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Introduction

Welcome to Sage ACT! 2011. Sage ACT! is the #1 selling
Contact and Customer Manager in the world.

This guide provides installation instructions for new users of:

Sage ACT! Pro 2011 - For professionals who work alone or
in small workgroups of up to 10* users.

Sage ACT! Premium 2011 - For professionals who work in
business teams and workgroups. This version includes access
via Windows® and the Web. If you are installing access for
users via the Web, then you will need this guide and the Sage
ACT! Premium 2011 Web Administrator's Guide to complete
installation and configuration. The Web Administrator's Guide is
available on the product's DVD under Product Documentation.

IMPORTANT: If you have a previous ACT!, ACT! Premium, or
ACT! Premium for Web version installed, DO NOT USE THIS
GUIDE. Instead, see the Upgrading Guides provided on the
Installation DVD under Product Documentation. Guides are
available for users upgrading from ACT! 3.x, 4.x, 5.x (2000), or
6.x (2004) and ACT! 2005 -2012 versions.

NOTE: Adobe® Reader® is required to access and view
Product Documentation. Installation instructions for a free copy
of Adobe Reader are provided in the "Installing Other
Applications" section of this guide.

When features are exclusive to Sage ACT! Premium or Sage
ACT! Premium (Web client), they are noted in the guide. In
most sections, we refer to all versions as Sage ACT! 2011.

* Some operating systems may limit concurrent connections.
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What You Should Know Before Installing

This section contains information you should know before
installing Sage ACT! 2011.

Microsoft® SQL server® 2008 Express R2 and
required components - Sage ACT! 2011 automatically
installs Microsoft SQL Server 2008 Express R2, which requires
.NET Framework 3.5 SP1 and Windows® Installer 4.5
components. These components are installed for you if they
are not already on your computer.

NOTE: If you plan to have two or more Sage ACT! users, all
connected to the same database, and the database is on a
separate server, you do not need to install Microsoft SQL
Server Express on every computer. However, be aware that
SQL Server Express is needed to create or synchronize a
database. If you opt to skip the SQL Server Express install
and your organization needs to synchronize or cut remote
databases, make sure that SQL Server Express is installed on
the computer that will host the database.

Microsoft Outlook®, Word, and Excel® integration
- Sage ACT! 2011 integrates with Microsoft Outlook, Word,
and Excel. (For compatible versions, see System
Requirements at www.act.com/2011systreq). If you plan to
use the integration features, ensure Outlook, Word, and Excel
are installed and working correctly before you install Sage
ACT! 2011. To configure and set up integration for Sage ACT!
Pro or Sage ACT! Premium users after installation, see Help.
To configure and set up integration for Sage ACT! Premium
(Web client) users, see the Sage ACT! Premium 2011 Web
Administrator's Guide.
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Installing, Registering, and Activating
Sage ACT! 2011

This section explains how to prepare for installation, install,
register, and activate the software for first-time (new) users.

IMPORTANT: If you are installing Sage ACT! Premium (Web
client) with a multiple-server configuration, you must install
Sage ACT! Premium on the database server (even though you
will be running the application from the Web server). Installing
the software on the database server creates the Microsoft SQL
Server instance. You connect to the database from the Web
server.

TIP: To install Sage ACT! Premium in a workgroup
environment without user interaction, you can install it silently.
For more information, contact Sage ACT! Corporate Sales.

Preparing to Install

To ensure a successful installation, complete the following steps
before installing Sage ACT! 2011.

Prepare to install

1. Ensure your computer (or all computers if installing the
software in a shared environment) meets the minimum
recommended system requirements for your purchased
product and supported operating systems. Also, verify
you meet the concurrent user limits and licenses. See
System Requirements at www.act.com/2011systreq.

2. Ensure all computers are up-to-date with Microsoft
critical and recommended updates.

3. Signon to all computers as a Microsoft Windows
Administrator.
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4, If you use a software-based firewall, you must
temporarily disable it to install the software.

5. During installation, you can select Custom to install to
a non-default location. To install Sage ACT! 2011
and/or Microsoft SQL Server Express to a location other
than the default location, do the following:

a. For Sage ACT! 2011: Verify directories exist and
folder-sharing rights are enabled.

b. For SQL Server Express: Ensure the installation
folders are unique to this instance of SQL Server.
None of the directories should be shared with
directories from other instances of SQL Server.
For more information, see Microsoft
documentation.

6. If you plan to install Sage ACT! Premium (Web client),
do the following:

a. Sage ACT! Premium (Web client) requires IIS

and ASP.NET to run in 32-bit compatibility mode.
If you are running 64-bit versions of these
applications and do not want Sage ACT! Premium
(Web client) to automatically switch them to 32-
bit mode, see "Troubleshooting Sage ACT!
Premium (Web client)" in the Sage ACT!
Premium 2011 Web Administrator's Guide.

b. See Microsoft documentation to help you plan
your installation and prepare your Web server.
You need to understand your operating system,
Microsoft Internet Information Server (IIS),
ASP.NET, and user permissions required to run a
Web page.
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c. Install or enable the correct version of IIS for your
operating system and verify it runs properly.

d. Verify ASP.NET impersonation authentication is
enabled.

e. If using a firewall, enable an exception for World
Wide Web services.

f. Give your Web server a static IP address and make
a note of the IP address because you will need it
later.

g. Gather the virtual directory names of other Web
sites hosted on your Web server.

h. If you use Windows XP, disable Simple File
Sharing.

i. If you plan to use Windows Vista® as a Web server

to host Sage ACT! Premium (Web client), change
the "sleep mode" setting to Never.

Installing Sage ACT! 2011
The installation program automatically checks for and installs
required components. The component installation may require a
restart of the computer. If a restart is required or components
cannot be installed, a message appears. Follow the instructions.
TIP: You can copy the contents of the installation DVD to a
network drive or external hard drive for installation on
computers that do not have a DVD or CD drive.

Install Sage ACT! 2011
1. Close all open applications.

2. Insert the Sage ACT! 2011 DVD.
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If the DVD does not automatically start, click the
Start menu, and select Run. Type <drive
letter>:SETUP. Click OK. Or, in the Start Search box,
type <drive letter>: SETUP. Press Enter. (Substitute
the appropriate drive letter).

From the browser page, click Install [Sage ACT!
Pro 2011] or [Sage ACT! Premium 2011] or
[Sage ACT! Premium (Web) 2011].

Follow the onscreen instructions. Click Next to
continue.

If prompted, agree to install the required components.

Installing the required components may take a few
minutes depending on your computer's configuration.
If prompted, a restart of your computer may be
necessary.

You must Accept the License Agreement for
installation to continue. (If you Decline, installation is
cancelled). Click Next.
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7. Onthe Type of Install page, Typical installation is
selected by default. However, if you want to change the
default settings, select Custom. Click Next.

For a Custom installation, you can:

e Select different installation folders for Sage ACT!
and SQL Server.

e Install the software without installing SQL
Server Express. To do this, clear the Install
SQL Server Express check box.

IMPORTANT: Several Sage ACT! 2011
features do not function when you install
without SQL Server Express. For more
information, see the Knowledgebase and
system requirements.

e Select who can use the software on the

computer.

e Select the Start menu Program Folder for the
software.

e Select to add the software icons to your desktop
and Quick Launch toolbar.

The installation process starts. The amount of time
required to install depends on your computer
configuration.
8. Onthe Install Complete page, select or clear options.
Click Finish.

If you selected the option to launch (start) the software, when

it opens, you can register and activate the software, or open it

in trial mode for 30 days.
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If an Update message appears, you can click Yes to check for
software updates, or you can click No to continue with
registration or trial mode. You may receive other update
notices as you use the software.

Registering and Activating Sage ACT!
2011

You must register and activate the software within 30 days of
first use on each computer where it is installed. Registration
and activation provides you with program updates, upgrade
offers, and customer support options. A serial number is
required to register. The serial number is printed on the DVD
sleeve or is e-mailed to you in a purchase confirmation e-
mail. You can register by Internet, telephone, or e-mail.
(Registration by e-mail may not be available in some
locales.)

Windows Vista: You must register the software as an
Administrator. Close the application, right-click the Sage
ACT! icon on the desktop or in the Program Files list. Click
Run as administrator.

Register and activate the software
1. From the Help menu, click Register Sage ACT!.

2. Onthe first page, select a registration option. Click
Next.

3. Follow the onscreen instructions. Click Next to
advance.

4. When finished, click Activate.

If error messages appear, follow the instructions.
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Next Step(s)
Sage ACT! Premium (Web client) Users:

e Set up user access to Sage ACT! Premium through an
Internet browser. See the sections "Creating a Database"
and "Adding Users" in this guide.

e Configure access for your Web users and complete other
configuration tasks. See the Sage ACT! Premium 2011
Web Administrator's Guide.

All Users:

e Install other applications to use with the software. See
the section "Installing Other Applications" in this guide.

e Get started using the software. See the section "Getting
Started for New Users" in this guide.

Other Information

This section contains other information you may need to know
to start using Sage ACT! 2011.

Sage ACT! 2011 includes several other services:

e Sage E-marketing for ACT! (powered by Swiftpage™, a
third-party company). This is an email marketing service
that enables you to execute marketing campaigns using
techniques proven to build your business.To use this
service, you must purchase a subscription and access
content hosted by Swiftpage. However, a trial period to
use the service is provided.
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e Sage Business Info Services for ACT! (provided by
Hoover’'s™, a third-party company). This service uses
targeted prospect lists and business information from
Hoover’s and lets you access the information from
Sage ACT!. To use this service, you must purchase a
subscription and access content hosted by Hoover’s. A
free level as well as several purchase levels are
available.

SData™ integration with Sage applications - Sage
ACT! 2011 includes SData Integration with Sage accounting
applications. SData™ (Sage Data™) is a Sage-wide
interoperability technology that provides standard
communication protocol between Sage applications. This
integration lets you share information between Sage ACT! Pro
or Sage ACT! Premium 2011 and a Sage SData™-compliant
accounting application. (Note: SData™ integration is not
available in Sage ACT! Premium (Web client)). For a list of
compatible Sage accounting applications, see the Sage ACT!
Knowledgebase.

Installing Other Applications

You can install the following applications for use with Sage
ACT! 2011:

e Adobe Reader

e Sage ACT! Synchronization Services (available for
Sage ACT! Premium only)

Adobe Reader

To view product documentation (accessed from the
installation DVD browser and the software), you must have
Adobe Reader installed. You can install a free copy of Adobe
Reader from the Adobe Web site.
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Install Adobe Reader

1. From the Sage ACT! 2011 DVD browser, click Product
Documentation.

2. Click the link to go to the Adobe Web site.

3. Download and install Adobe Reader.

Sage ACT! Synchronization Services
Sage ACT! Premium offers two data synchronization services.
These services let remote workgroup users, with their own Sage
ACT! Premium database, synchronize their data to the main
workgroup database. (For more information about database
synchronization, see Help.) You can install one or both services
depending on your needs. Sage ACT! Pro users can synchronize
data between a main and remote database, but do not use the
synchronization services. For more information about the type
of data synchronization available to Sage ACT! Pro users, see
Help.

Sage ACT! Network Synchronization Service - Used to
synchronize Sage ACT! Premium databases over a network. The
service is designed for remote users connected to the main
database via a Local Area Network (LAN), Wide Area Network
(WAN), or a Virtual Private Network (VPN), when the main
database is not open. You can install the Sage ACT! Network
Synchronization Service on the same computer as Sage ACT!
Premium or on another computer.
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Sage ACT! Internet Synchronization Service - Used
to synchronize Sage ACT! Premium databases over the
Internet when the main database is not open. This service
requires a computer (located outside the firewall) with
ASP.NET and a compatible version of Microsoft Internet
Information Services (IIS) installed for your operating
system. See System Requirements at
www.act.com/2011systreq.

Installing Sage ACT! Sync Services

The following explains how to install the Sage ACT! Sync
services. After installing one or both of the services, you must
set up (configure) them.

IMPORTANT: If you install the Sage ACT! Internet Sync
Service on a computer that does not have Sage ACT!

Premium installed, ensure the <computer name>\ASPNET
account has read/write permissions on the Internet Sync
install folder. For more information, see Help.

Install the Sync Services
1. Insert the Sage ACT! Premium DVD.

2. Click Install Sage ACT! Synchronization
Services.
3. Do the following:
e To install the Network Sync service, click Sage
ACT! Network Synchronization Service.
e To install the Internet Sync service on the IIS

computer, click Sage ACT! Internet
Synchronization Service.
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4. Follow the onscreen instructions. Click Next to advance.
Click Finish.

Next Step(s)

e Set up the Sync Services, see Help.

Getting Started for New Users

To help you get started using the software, you can read the
Quick Start for New Users Guide and view some of the Featured
Videos. These resources are available on the Sage ACT! 2011
Welcome Page.

To start entering your information, you need to create a
database to store your contacts' details. If you want to share
your information, and allow others to add their information to
the database, you need to add the others as Users to the
database.

When you open the software for the first time, you are
prompted to create a new database or open an existing one. If
you do not have an database, you would select to create one. If
you are joining a workgroup and have been given details about
a database that is already set up for you, you would select to
open an existing database.

TIP: To see an example of a customized database, you can
open the demonstration database, ACT2011Demo, which is
installed with the software. You can view the sample contacts,
groups, activities, and other data included in the database. The
user name logon for the demo database is Chris Huffman with
no password.

The following sections provide the steps to:
e Create a database.

e Add users to that database.
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e Show you how to set up the software for use over a
network.

Creating a Database

The following explains one way to create a database. If you
know others will need access to the data, you can share the
database. Once the database is created, you add the people
requiring access as Users.

When you create a database, the database and a file that
points to the database are created. The pointer file has a PAD
extension. The .PAD file is used to open a database. For
example, if you name the database "WorkDatabase", the
pointer file is named WorkDatabase.PAD. If you share the
database with others, you can send them a shortcut to the
.PAD file so they can open the database. For more
information, see "Sharing Databases" in Help.

IMPORTANT: For a Sage ACT! Premium (Web client)
installation, if you use a single-server configuration, create
the database on the Web server. If you use a multiple-server
configuration, create the database on the database server.

Create a database
1. From the File menu, click New Database.

2. Inthe Database name field, type a name for the
new database.

The name must begin with a letter. Do not include
spaces or punctuation.

3. Inthe Location field, keep the default information, or
to save the database to different location, click
Browse. Select the location. Click OK.
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4. Inthe Currency field, from the list, select a currency
for the database.

5. To share the database with others, select the Share
this database with other users check box.

6. Inthe User name field, type the name of the person
who will be logging on to the database.

This step creates a contact record known as My Record
and in most cases, this will be your name. This contact
is given the Administrator security role. (For more
information about user security roles and the features
and data they can access, see Help.)

7. To set a logon password for the user, in the Password

field, type a password and type it again to confirm.

CAUTION: If you forget this password, you will not be
able to access the database. You will have to contact
Technical Support.

8. Click OK.

Adding Users
If other people need access to the database, you must add
them as Users. You can assign them security roles and
permissions to limit their access to data and features. You can
add any number of users. However, you are limited by your
license for the number of users that can be active.

Add a user
1. From the Tools menu, click Manage Users.

2. Onthe Select a User page, under User Tasks, click
Create New User.
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3. Onthe Create New User page, select an option for
the source of the user information. Click Next.

4. Onthe Enter User Information page, complete the
User Name, Security Role, and Password fields.
Click Next.

5. Onthe Specify Access page, select a logon access
option. Click Next.

6. Onthe Add Permissions page, use the arrow buttons
to add or remove permissions for the user.

By default, some permissions are automatically
added for the user because of the security role
selected for him or her. You can add or remove as
needed.

7. Click Finish.

Setting Up For Use Over a Network
The following explains how to set up the software and
database to be used over a local area network (LAN) or a
virtual private network (VPN).

TIP: If you do not use the server (host) computer to access
the database, you can use one of the same serial numbers for
a client computer.

Set up for use over a network

1. Ensure each computer (host and clients) has a licensed
copy of the software.

2. Verify each computer has the same version of the
software installed. To check the version: From the Help
menu, select About Sage ACT!. The version nhumber
appears at the top of the page.
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3. Add Sage ACT! 2011 to the list of firewall exclusions.
Refer to Windows Help for more information.

4. On the host computer, do the following:
a. Create a database and share it.
b. Add users to the database.

Close Sage ACT! 2011.

o

d. To set sharing rights, permissions for full
read/write access, and full security rights to the
database folder and its supplemental files for all
users, browse to the Databases folder. Set
sharing, permissions, and access.

By default, depending upon the operating system
you use, the Databases folder is installed to the
\\Users\[username]\Documents\ACT\ACT Data or
\\Documents and Settings\[username]\ACT\ACT
Data location. For more information about
databases, supplemental files, and personal
supplemental files, see Help.

e. To allow sharing of personal supplemental files,
such as saved documents, Internet links, and
dictionaries between users, create a shared folder
for each type of data and allow full control to all
users.

f. Copy the database's .PAD file to a network location
so that you can access it from each client's
computer or copy it to a USB memory stick.

5. On each client computer, do the following:
a. Browse to and open the Databases folder.
b. Paste the .PAD file copied from the host computer.
c. Double-click the .PAD file to open the database.
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d. To share the user's saved documents, Internet
links, and dictionaries, change the Preferences
setting: From the Tools menu, select
Preferences. On the General tab, in the
Personal Files Locations, change the
locations to the shared folders on the host
computer.
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